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Overview 

Intended Use (RUO) 

This technical user guide is for PANDAA® Lassa Virus, a Research Use Only (RUO) real-time RT-PCR 
assay for the amplification and qualitative detection of Lassa virus RNA. PANDAA Lassa Virus is uniquely 
designed to provide accurate and rapid information for the identification of Lassa virus and PANDAA 

VHF Interpretation Software may be used to support analysis and interpretation of results. Use the most 
current version of this instructions for use available at www.aldatu.bio/downloads. 

This kit is for Research Use Only and is not intended for use in diagnostic procedures.  

PANDAA Lassa Virus Test Principle 

PANDAA Lassa Virus assay is comprised of single reaction mix containing reagents to amplify and 
detect all known lineages of Lassa virus. The Lassa virus target, located in the L segment, is amplified 

by PANDAA primers and detected by a FAM-labelled hydrolysis probe.  

An exogenous, non-competitive internal control is included to monitor for successful nucleic acid 

extraction and for the presence of RT-PCR inhibitors. A sample adequacy control (SAC) detects 
endogenous human RNase P in samples derived from human biological material to control for sample 
quality and to ensure adequate addition of sample to the reaction. 

The entire PANDAA Lassa Virus workflow can be completed in two hours.  
Assay preparation takes ~30 minutes with a 
PCR run time ~70 minutes. Prepare the 
PANDAA mastermix by adding Stop-Start RT 

enzyme and PANDAA to the PRxB buffer. 
Dispense 10 µL of mastermix into each PCR 
well/tube, then add sample RNA to each well/tube. No mixing is necessary.  

Compatible Real-Time PCR Instruments 

Any real-time PCR instrument that can detect fluorophores in the green, yellow, and red channels, such 
as those listed in Appendix B. 

PANDAA Technology 

Aldatu Biosciences’ detection and genotyping PANDAA technology uniquely compensates for evolving 
pathogen diversity, ensuring that PCR diagnostic integrity isn’t affected by genomic variation now, or in 
the future. PANDAA is designed to mitigate genomic variability by normalizing probe-binding regions. 

During the initial real-time PCR cycles, the target genome is adapted through site-directed mutagenesis 
to replace any polymorphisms that could cause false negative results.  
Read the methods publication here: https://www.nature.com/articles/s42003-021-01751-9. 
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Contents and Storage 

Reagents  

The kit includes all amplification reagents for 96 reactions and includes one (1) each of the Positive 
Control, Negative Control, and Internal Control RNA. Refer to Appendix A for a list of materials 
required but not included. 

Contents Cap color Top Label Quantity Volume 

PRxB II Buffer Clear PRxB 2 500 µL 

Lassa Virus PANDAA White PAN LASV 2 35 µL 

Stop-Start RT Enzyme Blue RT 1 8 µL 

Internal Control RNA Yellow  INT CTRL 1 120 µL 

Positive Control Red POS 1 100 µL 

Negative Control Green NEG 1 100 µL 

 

Storage and Stability 

PANDAA Lassa Virus is shipped on dry ice, and kit components arrive frozen. Store all components at 

−15 °C to −25 °C upon receipt, protected from light. Stop-Start RT enzyme contains glycerol and may 

remain liquid at −15 °C to −25 °C. Keep reagents in the original packaging when not in use and return 

them promptly to recommended storage conditions. For receiving inspection and handling, see General 
Guidelines → Shipping, Storage and Handling (page 22). 

A unique feature of PANDAA assays is that, after thawing, all components except Stop-Start RT 
enzyme may be stored at 2 °C to 8 °C for up to 7 days, protected from light. To maintain assay 
performance, avoid more than two freeze-thaw cycles for any reagent.  

Contents Stability at 2 °C to 8 °C 

PRxB II Buffer 

7 days 

Lassa Virus PANDAA 

Internal Control RNA 

Positive Control 

Negative Control 

Stop-Start RT Enzyme Should only be stored at −15 °C to −25 °C 

 NOTE: All reagents, other than the Stop-Start RT enzyme, may be stored  
at 2 °C to 8 °C for up to one week after thawing. 
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Reagents Description 

PANDAA Reaction Buffer (PRxB) 

A complete custom assay buffer that is compatible with high, low and no ROX real-time PCR machines. 
Contact Technical Support (support@aldatubio.com) with questions about your real-time PCR 

instrument requirements and configuration. 

Stop-Start RT Enzyme 

A specially formulated hot-start reverse transcriptase optimized for PANDAA. 

Lassa Virus PANDAA 

Includes uniquely designed PANDAA primers and probes for the amplification and detection of three 

distinct targets:  

 Lassa Virus (LASV): targeted to the L segment of the Lassa virus genome.  

 Internal Control (IC): detects the internal control RNA, which serves as a process control for 
both RNA extraction and PCR amplification. 

 Sample Adequacy Control (SAC): detects human RNase P in samples derived from human 
biological material to control for the quantity, quality and adequacy of the specimen. 

Extraction and Amplification Controls 

 Internal Control (IC) is an exogenous, non-competitive control that detects MS2 phage-specific 
RNA, which should be either spiked into the lysis buffer prior to extraction or added directly to 
the real-time PCR reaction mix.  

 Positive Control is a synthetic, non-infectious RNA covering the assay target regions in the Lassa 
virus genome of the Nig-08-A18 isolate, provided at 150 copies/µL to yield 1,500 copies/reaction 
when using 10 µL control per reaction. It is prepared in a background of human genomic DNA 

and Internal Control RNA. 

 Negative Control comprises ~0.1 ng/µL human genomic DNA, which is ~30 copies/µL to yield 
~300 copies/reaction when using 10 µL control per reaction, and includes Internal Control RNA. 
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Sample Preparation for PANDAA Lassa Virus  

The starting material for the PANDAA Lassa Virus kit is isolated viral RNA. If samples have already been 
extracted then proceed to PANDAA Lassa Virus Kit Step-by-Step Instructions on page 9. 

Nucleic Acid Extraction 

Compatible Extraction Reagents 

Many commercially available nucleic acid extraction systems are compatible with real-time PCR and 
are suitable for sample preparation prior to PANDAA Lassa Virus testing, including systems that purify 
total nucleic acid (DNA and RNA). Follow the extraction kit manufacturer’s instructions for the nucleic 
acid extraction kit or workflow used to viral RNA. 

Sample Volume 

The minimum sample input volume for nucleic acid extraction is 100 µL. Sample input volume may vary 
by platform and should be maximized to optimize test sensitivity. Refer to Analytical Sensitivity - System-
Level Limit of Detection (IU/mL) (page 18) for PANDAA Lassa Virus performance with EDTA plasma. 

Recommended specimen type Human plasma collected in EDTA tubes 

Minimum sample volume 100 µL 

Required Elution Volume 

Elution volume may vary by nucleic acid extraction protocol and should be optimized to maximize RNA 
recovery while minimizing dilution. Typical elution volumes range from 50 µL to 100 µL. Each PANDAA 
Lassa Virus reaction requires 10 µL eluted RNA. 

Extracted RNA Handling 

Use extracted RNA as soon as possible after extraction. If testing is delayed, extracted RNA may be 
stored at 2 – 8 °C for up to 6 hours. Extraction eluants and storage conditions can affect RNA stability, 

which may reduce detection in low-copy-number samples. 

Provided Controls 

Internal Control for RNA Extraction 

The Internal Control (IC) RNA provided can be added to the sample extraction kit lysis buffer to serve 
as a full process control and verify successful RNA extraction as well as downstream 

amplification/detection. For each sample being processed, add 1 µL IC to the sample extraction lysis 
buffer e.g., if processing 48 samples then add 48 µL IC to the lysis buffer.  
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PANDAA Lassa Virus Kit Step-by-Step Instructions 

A. Before Beginning 

PANDAA Lassa Virus is a highly sensitive molecular assay. To prevent false-positive results, follow a 
strict unidirectional workflow. Always use separate, dedicated lab areas and equipment for reagent 
preparation and for sample/control addition.  

 ❚❛❜ 
CAUTION 

In a dedicated lab area for setting up PCR reaction mixes 

Remove reagents from storage and place at room temperature to thaw. Estimated 
thawing times are 10 minutes for PRxB buffer and 5 minutes for PANDAA tubes. 

Remove Stop-Start RT enzyme (RT) from the freezer and place it directly on ice. 
Tubes should be placed on ice after thawing. 

B. PANDAA Lassa Virus Mastermix Setup (48 Reactions) 

1. Prepare reagents: Spin the reagent tubes briefly to collect drops on the interior sides of the tubes. 
Gently vortex the reagent tubes and spin briefly again. 

2. Add reagents to PRxB tube: 

a. Add 30 µL Lassa Virus PANDAA directly to the PRxB tube. 

b. Add 3 µL Stop-Start RT enzyme directly to the PRxB tube.  

 Submerge only the tip of the pipette to ensure that no excess RT droplets are transferred to 
the exterior of the tip. 

c. If Internal Control (IC) was not added to the lysis buffer prior to sample extraction, it should 

be added to the PRxB tube here. 

 For 48 samples, add 3 µL Internal Control (IC) to the PRxB tube if the IC was not added to 
the lysis buffer prior to sample extraction. 

3. Mix reagents: Gently vortex the PRxB tube containing the Stop-Start RT enzyme, PANDAA, and 
Internal Control (if not added to the sample extraction lysis buffer). Spin to collect any droplets. 

NOTE: 24 reactions modification 

Remove 250 µL PRxB buffer and transfer to a clean tube. Add 15 µL Lassa Virus 
PANDAA and 1.5 µL Stop-Start RT Enzyme. Add 1.5 µL IC RNA only if the IC 
was not added to the lysis buffer. 

Follow the storage instructions on page 6 for the remaining reagents. 
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C. Real-time PCR Plate Setup  

1. Dispense mastermix: Add 10 µL of the complete mastermix from the PRxB tube into each 
required well of an optical 96-well reaction plate or to each optical reaction tube compatible with 

your real-time PCR instrument. 

 ❚❛❜ 
CAUTION 

Perform the remaining steps in a pre-amplification area 
designated for RNA handling in your laboratory 

 

2. Add sample or controls: Add 10 µL sample RNA, Positive Control, or Negative Control into the 
top of the mastermix in each well / tube. Do not pipette up and down to mix. 

3. Seal and spin (plate only): Seal the plate with optical adhesive film or cap the reaction tubes. If 
using a 96-well plate, spin the plate briefly before loading into the real-time PCR instrument.  

 

D. Real-time PCR Protocol 

1. Proceed immediately to loading the plate / tubes into the real-time PCR instrument. 

2. Use the real-time PCR template provided by Aldatu Biosciences, which can be downloaded from 
www.aldatu.bio/qpcr-templates. Total run time should be 60 to 80 minutes. 

  

NOTE: Fewer than 48 reactions 

If you require fewer than 48 reactions, prepare mastermix for 48 samples and 
store any unused volume. The complete PANDAA Lassa Virus mastermix (PRxB, 
Stop-Start RT enzyme, and PANDAA (with or without Internal Control) is stable for 
up to 48 hours when stored at 2–8 °C. 
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E. Manual Real-time PCR Settings 

Use the real-time PCR run template provided by Aldatu Biosciences, available at www.aldatu.bio/qpcr-

templates. Aldatu Biosciences cannot accept any responsibility for inaccurate data that has been 
generated through incorrect manual programming of the real-time PCR instrument.  

Use the following parameters and proceed to run the PANDAA real-time PCR. Refer to Appendix B 
(page 25) for detection channel settings for compatible real-time PCR instruments. For assistance 
with instrument configuration, contact Aldatu Biosciences Technical Support (support@aldatubio.com). 

Real-Time PCR Instrument Settings 

Setting Value 

Reaction volume 20 µL 

Ramp rate Fast, if compatible with your real-time PCR instrument. Otherwise use 
standard ramp rates. Refer to page 20 for ramp temperatures. 

Passive reference (if applicable) ROX 

 

Target Name Ex / Em (nm) Channel Reporter 

PANDAA Lassa Virus (LASV) 495 / 520 Blue/Green* 
Refer to Appendix B (page 25) 
for instrument-specific reporter / 
dye settings. 

Internal Control (IC) 650 / 670 Red 

Sample Adequacy Control (SAC) 554 / 576 Yellow 

*Channel name may differ between instruments. 

Cycling Conditions 

During the 60 °C anneal and extension phase of the Amplification and Detection step, acquire 
fluorescence data in the green, yellow, and red channels. 

Step Temperature Time Cycles 

Reverse transcription 50 °C 15 minutes 1 

Enzyme activation 95 °C 2 minutes 1 

PANDAA adaptation 

95 °C 

55 °C 

60 °C 

1 second 

30 seconds 

30 seconds 

10 

Amplification and detection 
95 °C 

60 °C 

1 second 

(acquire) 60 seconds 
30 
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PANDAA LASV Qualification Panel  

 

PANDAA Lassa Virus Kit Quick Guide 

  

NOTE: PANDAA LASV Qualification Panel 

For first-time instrument use, perform a preliminary run with the PANDAA LASV 
Qualification Panel (catalog #2121096), provided free with any Aldatu assay 
order. The panel contains ten synthetic, non-infectious RNA samples: nine positive 
controls covering seven LASV isolates and one negative control (LCMV). Contact 
support@aldatubio.com for details or visit www.aldatu.bio/lasv-panel. 
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Data Analysis and Interpretation of Results 

Real-Time PCR Analysis Parameters 

Refer to Appendix B (page 25) for instrument-specific analysis settings, including threshold settings for 
determination of Ct values for the PANDAA Lassa Virus, Internal Control, and Sample Adequacy Control 
targets. For technical assistance, contact Aldatu Biosciences at support@aldatubio.com. 

 

Threshold Settings 

Adjust the LASV threshold following the instrument-specific analysis settings in Appendix B (page 25). 
Use the instrument’s automatic threshold for IC and SAC (recommended). If set manually, place the IC 

and SAC thresholds in the exponential (log-linear) region above baseline and below plateau; apply the 
same setting to all samples and controls. 

 

Fluorescence Cutoff  

Minor non-specific increases in fluorescence due to probe hydrolysis, dye crosstalk, or signal drift can 
produce spurious Ct values in the absence of genuine target amplification. The fluorescence cutoff 
distinguishes these artefactual signals from true positive results. 

At the end of the PCR run, a fluorescence cutoff of 5% should be applied to confirm negative results. 
A well is called negative if its baseline-subtracted endpoint fluorescence (ΔRn on Applied Biosystems 
and Thermo Fisher instruments; baseline-subtracted endpoint RFU on Bio-Rad CFX instruments; 
fluorescence change on Qiagen Rotor-Gene and Mic instruments) is less than 5% of the highest 
baseline-subtracted endpoint fluorescence detected on the plate. The highest value on the plate is 

typically the on-plate Positive Control. Refer to Appendix B (page 25) for instrument-specific 
instructions. The fluorescence cutoff is determined automatically when using the PANDAA VHF 
Interpretation Software. 
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PANDAA VHF Interpretation Software (Recommended) 

PANDAA VHF Interpretation Software is a free, automated tool for reviewing and interpreting Aldatu 

PANDAA real-time PCR run files for viral hemorrhagic fever assays. The software can import data 
directly from instrument files generated by supported real-time PCR instruments, apply standardized 
analysis thresholds, evaluate control validity, and generate summary reports, typically in a few seconds 
after importing a run file. Refer to the PANDAA VHF Interpretation Software instructions for use for 
installation, supported instruments, and detailed operating instructions.  

Download the PANDAA VHF Interpretation Software from www.aldatu.bio/vhf-software. 

Key Capabilities 

 Automatically analyzes results directly from instrument data files from multiple real-time PCR 
instrument platforms. 

 Applies standardized analysis criteria (Ct and fluorescence cutoff thresholds). 

 Validates quality controls with a structured flag framework. 

 Generates formatted reports (PDF and Excel) for documentation and review. 

 Provides "Detected/Not Detected" interpretations with appropriate validity flags. 

Supported Instruments and File Types 

The software can currently accept the analyzed instrument run file directly from multiple instruments 
and accepts results files from the following real-time PCR instruments in the formats below. 

 

Instrument Supported File Formats 

QuantStudio 5 .eds, .xlsx 

QuantStudio 7 Pro .eds, .xlsx 

7500 / 7500 Fast .eds, .xls 

Rotor-Gene Q .rex, .csv 

Mic .micrun, .xlsx 

CFX96 .pcrd, .xlsx 

LightCycler 96 .lc96, .txt 

LightCycler 480 II .ixo, .txt 

 



PANDAA® Lassa Virus
 

 

ABIO-LASSA-IFU-0003/R:0 Page 15 of 40 

Positive and Negative Controls Interpretation 

These PCR controls must be included in every run for the results to be valid. The Positive Control must 

have a Ct < 30 cycles for the LASV target to pass quality control; the LASV target must not be detected 
in the Negative Control. 

 

Control Target Call Results Interpretation 

POS 

LASV + 

PASS 
Positive Control passed QC as the LASV Ct is below the cut-
off. 

IC + 

SAC + 

POS 

LASV - 

FAIL 
Positive Control failed QC as the LASV Ct is above the cut-off.  

This may indicate an error during setup, inefficient sample 
extraction or amplification reagent issues. 

IC + 

SAC + 

NEG 

LASV - 

PASS 
Negative Control passed QC as the LASV Ct is above the cut-
off. 

IC + 

SAC + 

NEG 

LASV + 

FAIL 
Negative Control failed QC as the LASV Ct is below the cut-
off. This may indicate an error during setup or cross-
contamination. 

IC + 

SAC + 
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Results Interpretation 

A Ct value < 30 cycles for the PANDAA Lassa Virus (LASV) target indicates that Lassa virus RNA is 

present in the sample. If the LASV target is ≥ 30 cycles, or not detected, and the Internal Control Ct 

value is < 30 cycles then Lassa virus RNA is not present.  

If both the LASV and Internal control Ct is ≥ 30 cycles, or not detected, then there has been a reagent 

or extraction failure and the sample should be repeated.  

LASV IC SAC Call Results Interpretation / Recommended Action 

+ ±* ±* Positive 
Lassa virus RNA detected. Detection of IC or SAC is 
not required for a positive result. 

- + + Negative 
Lassa virus RNA not detected; successful RNA 
extraction and sample adequacy verified. 

- + - Invalid Result 

SAC not detected; inadequate human biological 
material, inappropriate specimen collection, or 
compromised specimen integrity. Repeat extraction 
and/or obtain a new specimen. 

- - + Invalid Result 
Internal control not detected; indicates a potential 
reagent or extraction failure. Repeat extraction 
and/or obtain a new specimen. 

- + N/A† Negative 
Lassa virus RNA not detected; successful RNA 
extraction verified. Sample adequacy control is not 
applicable for non-human biological specimens. 

- - N/A† Invalid Result 
Internal control not detected; indicates potential 
reagent or extraction failure. Repeat extraction 
and/or obtain a new specimen. 

±*: Detection of Internal Control (IC) and Sample Adequacy Control (SAC) is not required to interpret a positive result for 

LASV, as high viral load can suppress these signals. 

N/A†: SAC is not applicable when testing samples that are not derived from human biological material. In these cases, only 

the Internal Control is required for result interpretation. 

* Internal Control and Sample Adequacy Control Interpretation 

PANDAA Lassa Virus contains an exogenous, non-competitive extraction control (Internal Control) that 
is either spiked into the lysis buffer prior to extraction or added directly to the PRxB buffer. Additionally, 
PANDAA Lassa Virus contains amplification and detection reagents for the Sample Adequacy Control 
(SAC), which detects human nucleic acid. A high Lassa virus viral load may lead to the biased 
consumption of reaction amplification components and cause a delayed or absent Internal Control 

signal and/or Sample Adequacy Control signal. Therefore, detection of the Internal Control or Sample 
Adequacy Control is not required to call a positive result for Lassa virus.  
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Performance Characteristics 

Analytical Reactivity (Inclusivity) 

Analytical inclusivity (reactivity) was evaluated using 16 synthetic Lassa virus (LASV) templates. The 
inclusivity panel comprises sequence-verified RNA templates representing all known Lassa virus 
lineages selected to cover geographic and genetic diversity. Each template was tested at 500 

copies/reaction with 12 replicates per template (3 runs × 4 replicates). LASV RNA copy numbers were 
assigned by RT-qPCR using dPCR-traceable calibration.  

The PANDAA Lassa Virus assay detected 16/16 of isolates (100% detection) across valid replicates. 
Between isolate performance was consistent, determined by the ΔCt relative to the LASV prototype 

isolate, Josiah, with a pooled ΔCt range of 1.8 cycles (max−min of mean Ct values across templates). 

Internal Control (IC) and Sample Adequacy Control (SAC) were detected in 100% of positive control, 
negative control, and inclusivity panel replicates. 

 

Isolate Lineage Accession Mean Ct ± SD ΔCt 

LASV, AV V AY179171 20.5 ± 0.3 -0.1 

LASV, G1200-LIB-2010 IV KM821797 20.5 ± 0.1 -0.2 

LASV, IRR_010 III MK107886 21.7 ± 0.2 1.0 

LASV, IRR_016 III MK107845 21.0 ± 0.1 0.3 

LASV, IRR_060 II MK117909 20.9 ± 0.1 0.2 

LASV, ISTH_0779 II MH053556 21.3 ± 0.2 0.7 

LASV, ISTH2376-NIG-2012 II KM821997 21.6 ± 0.1 0.9 

LASV, Josiah IV NC_004297 20.6 ± 0.1 Ref 

LASV, KAK-428 VI KT992435 22.2 ± 0.1 1.6 

LASV, LP/Pinneo I KM822127 20.5 ± 0.1 -0.2 

LASV, Nig08-04 II GU481069 21.3 ± 0.1 0.6 

LASV, Nig08-A18 III GU481071 20.5 ± 0.1 -0.2 

LASV, Nig08-A37 II GU481075 20.8 ± 0.1 0.1 

LASV, ONM-299 III KT992433 22.1 ± 0.1 1.5 

LASV, Soromba-R V KF478762 22.1 ± 0.1 1.5 

LASV, Togo/2016/7082 VII KU961972 21.5 ± 0.1 0.9 
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Analytical Sensitivity - System-Level Limit of Detection (IU/mL) 

The limit of detection (LoD) of PANDAA Lassa Virus was estimated using the First WHO International 

Standard for Lassa virus (LASV) RNA (NIBSC 21/112; Lineage IV, Josiah).1 The 95% limit of detection 
of the PANDAA Lassa Virus assay as determined by probit is 203 IU/mL (95% CI: 146 – 283 IU/mL). 
This is equivalent to 4 IU/reaction, when extracting 100 µL plasma, eluting in 50 µL, and using 10 µL for 

PANDAA Lassa Virus. The system analytical sensitivity is for the end-to-end workflow (extraction → 

amplification) using the minimum sample volume of 100 µL plasma.  

For the initial estimation, the WHO Standard was spiked into pooled human EDTA plasma at 2,000, 
1,000, and 500 IU/mL, or with PBS as the extraction negative control. Nucleic acid was extracted using 
the QIAamp Viral RNA Mini Kit (Qiagen). For each concentration, 12 independent extractions were 
performed and 2 replicates per extraction were amplified on a QuantStudio 5 instrument following the 
Instructions for Use of the PANDAA Lassa Virus assay (n = 24 replicates per concentration). 

For the refined LoD estimation, the WHO Standard was spiked into pooled human EDTA plasma at 500, 
250, and 125 IU/mL, or with PBS for the extraction negative control for a total of 36 replicates per 

concentration.  

 

System sensitivity is reported in International Units per mL (IU/mL), traceable to the WHO International Standard (IS) 
21/112. For LASV, reporting sensitivity in copies/mL is not supported by an international standard and may not be 
comparable between laboratories or assays. WHO International Standards are the highest-order reference materials 
for biological substances; calibration to the WHO IS and reporting in IU supports inter-laboratory comparability and 
more robust determination of analytical sensitivity. 

  

 

1 Bentley EM, Richardson S, Atkinson E, et al. The development and evaluation of reference materials for Lassa virus 
molecular diagnostics. Front Virol. 2025;5. doi:10.3389/fviro.2025.1668042 

Concentration (IU/mL) PANDAA Lassa Virus Result Hit Rate 

2,000 24/24 100% 

1,000 24/24 100% 

500 24/24 100% 

0 0/24 0% 

 

Concentration (IU/mL) PANDAA Lassa Virus Result Hit Rate 

500 36/36 100% 

250 35/36 97.2% 

125 29/36 80.6% 

0 0/36 0% 
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Analytical Sensitivity - Assay-Level Limit of Detection (copies/reaction) 

As the WHO International Standard for LASV RNA is assigned in IU/mL and represents a single lineage, 

the assay-level LoD in copies/reaction was also estimated in copies/reaction using representative LASV 
templates spanning the breadth of sequence diversity across LASV lineages. The assay-level LoD is a 
distinct, claimable attribute that complements the system-level LoD in IU/mL verified separately for the 
full workflow (extraction → amplification). The two units are not interchangeable; together they provide 
a complete, traceable description of both the end-to-end system sensitivity (IU/mL) and the assay’s 

intrinsic detection threshold across targeted genetic diversity (copies/reaction). 

Data from four representative LASV isolates is shown. Synthetic RNA for each isolates was tested at 

20, 10, and 5 copies/reaction. Detection was summarized as the proportion of replicates with a 
Detected result at each input level. The assay-level LoD95 of the PANDAA Lassa Virus assay as 
determined by probit is 8.2 copies/reaction (95% CI: 7.2 – 9.3 copies/reaction). 

 

LASV 
Isolate 

5 cp/rxn 
Detected / N 

Hit rate  
10 cp/rxn 

Detected / N 
Hit rate  

20 cp/rxn 
Detected / N 

Hit rate  
LoD95 

(cp/rxn) 
95% CI 
(cp/rxn) 

KAK-428 48/60 80.0% 58/60 96.7% 60/60 100.0% 8.5 6.4 – 11.2 

ONM-299 47/60 78.3% 59/60 98.3% 60/60 100.0% 7.8 6.0 – 10.0 

Soromba-R 40/60 66.7% 59/60 98.3% 60/60 100.0% 8.2 6.5 – 10.3 

Togo 54/60 90.0% 58/60 96.7% 60/60 100.0% 7.3 5.2 – 10.4 

Pooled 189/240 79.1% 234/240 97.9% 239/239 100.0% 8.2 7.2 – 9.3 
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PANDAA Lassa Virus Compatibility with Major Real-Time PCR Instruments 

The study was conducted on five instrument models using the PANDAA LASV Qualification Panel 

(Aldatu Biosciences, catalog # 2121096): QuantStudio 5, 96-well Fast (QS5), QuantStudio 7 Pro, 96-
well Fast (QS7), Mic real-time PCR Cycler (Mic), ABI 7500 Fast (7500), and Rotor-Gene Q 5-Plex 
(RGQ). For the QS5, QS7 and 7500, both fast and standard thermal ramp rates were evaluated.2 For 
each instrument model and ramp rate, the study was conducted across two independent runs 
performed by separate operators. In each run, four independent replicates of each isolate and 

concentration in the table below was tested and four independent replicates each of the kit Positive 
Control and Negative Control. 

Baseline Ct values for all panel members were established on the QS5 with fast thermal ramp rates. For 
each comparison, the LASV threshold was adjusted until the mean Ct of the Positive Control (PC) 

replicates was within ± 0.5 cycles of mean PC Ct from the QS5 baseline. The average ΔCt relative to 

the QS5 fast for LASV-positive panel members was −0.1 cycles (SD: ± 0.2 cycles; range −0.7 to 0.4). 

LASV Isolate Copies 
Ct 

QS5 Fast 
ΔCt 

QS5 Std 
ΔCt 

QS7 Fast 
ΔCt 

QS7 Std 
ΔCt 

7500 Fast 
ΔCt 

7500 Std 
ΔCt 
Mic 

ΔCt 
RGQ 

LP/Pinneo 50 24.6 -0.1 0.0 0.0 0.2 0.1 -0.3 -0.4 

Josiah 50 24.7 0.0 0.2 0.3 -0.1 0.1 -0.3 -0.3 

Soromba-R 50 27.3 0.2 0.3 -0.3 -0.6 -0.4 0.0 0.1 

Togo 50 25.8 0.0 0.1 0.3 -0.2 0.0 0.4 0.4 

KAK-428 50 26.7 -0.2 0.1 -0.1 -0.4 -0.5 -0.3 -0.4 

Nig08-04 50 25.7 -0.2 0.1 0.1 -0.1 -0.4 -0.3 -0.4 

LCMV 5 × 103 N.D. N.D. N.D. N.D. N.D. N.D. N.D. N.D. 

Nig08-A18 5 × 104 14.4 -0.1 -0.1 0.0 -0.1 -0.1 -0.2 -0.2 

Nig08-A18 5 × 103 18.2 -0.1 0.0 0.0 -0.1 -0.1 -0.2 -0.1 

Nig08-A18 50 25.1 -0.3 -0.2 -0.3 -0.4 -0.7 -0.4 -0.4 

Pos Ctrl 1,500 19.9 0.0 0.0 0.0 0.0 0.0 -0.2 0.0 

Neg Ctrl N/A N.D. N.D. N.D. N.D. N.D. N.D. N.D. N.D. 

N.D. not detected 

Instrument Ramp Run Time (average) Software Used 

QS5 Fast: 75 min; Standard: 90 min QuantStudio Design & Analysis Software version 1.6.1 

QS7 Fast: 77 min; Standard: 90 min Design & Analysis Software. Release Version: 2.8.0 

7500 Fast: 78 min; Standard: 98 min 7500/7500 Fast Real-Time PCR System Software v2.3 

Mic Fast: 87 min micPCR Software v2.12.7 

RGQ Standard: 100 min Rotor-Gene Q Software version 2.3.5 

 

2 Fast thermal ramp rates were 4.1 °C/s (heating) and 3.1 °C/s (cooling). Standard thermal ramp rates were 1.6 °C/s (heating 
and cooling). 
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Procedural Limitations 

The PANDAA Lassa Virus kit is released for Research Use Only (RUO) and is not intended for use in 
diagnostic procedures. The assay is intended for use by lab personnel trained in the PANDAA Lassa 
Virus assay procedure and in the operation of nucleic acid extraction and real-time PCR systems used 
on site. Good laboratory practices and adherence to the Instructions for Use are required to minimize 
contamination and ensure reliable assay performance . 

This assay has been evaluated for use with human plasma and serum specimens. Analytical 
performance with human plasma and serum does not establish clinical diagnostic performance or 

clinical utility. Use of specimen types other than human plasma or serum has not been established and 
may yield inaccurate or uninterpretable results. 

A negative result does not exclude the possibility that Lassa virus RNA may be absent from the sample, 
below the assay detection limit, or affected by specimen quality, handling, storage, transport, extraction 
efficiency, or amplification interference. The Internal Control and Sample Adequacy Control are included 
in PANDAA Lassa Virus to help identify specimens containing substances that may interfere with nucleic 
acid isolation and PCR amplification. These controls do not eliminate the possibility of interference or 

other causes of invalid or non-representative results.  
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General Guidelines 

Shipping, Storage and Handling  

PANDAA Lassa Virus is shipped on dry ice, and kit components arrive frozen. Store all components at 

−15 °C to −25 °C upon receipt, protected from light. Stop-Start RT enzyme contains glycerol and may 

remain liquid at −15 °C to −25 °C. Keep reagents in the original packaging when not in use and return 

them promptly to recommended storage conditions.  

Inspect all kit components upon receipt. Do not use reagents if they appear compromised (e.g., cracked 
or leaking vials, illegible labels, or evidence of thawing. If a temperature excursion, shipping damage, or 
a discrepancy between the kit labels and this IFU is suspected, quarantine the kit and contact Technical 
Support (support@aldatubio.com) before use. 

Ensure all reagents are fully thawed and mixed before use. Keep Stop-Start RT enzyme on ice during 
handling. Perform the PANDAA Lassa Virus assay in environmental conditions at 20 °C to 25 °C and 
30% to 70% relative humidity.  

 

Real-time PCR Best Practices 

Since real-time PCR is a sensitive technique and the dynamic range of this assay extends to a very low 
template copy number, it is critical to perform accurate liquid handling to produce reliable results, and 
precaution must be taken when executing this protocol.  

 Handle reagents and RNA templates at separate / dedicated laboratory areas to prevent cross 
contamination.  

 Always ensure reagents and samples are fully thawed, thoroughly mixed and spun/centrifuged 
briefly before use.  

 Enzymes (Stop-Start RT enzyme and PRxB II buffer) and thawed viral RNA should be kept on ice 
while being used. 

 Ensure that a new pipette tip is used for each step in the protocol. Cross contamination between 
the samples and controls will affect the accuracy of the results.  

 Good laboratory practice should be observed at all times to avoid contamination of reagents, 
samples, consumables, pipettes, and work areas. 
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Safety  

Handle all specimens, extracted nucleic acids, and used consumables as potentially infectious and in 

accordance with applicable institutional biosafety procedures and local regulations. Wear appropriate 
personal protective equipment (PPE) (e.g., gloves, lab coat, and eye protection) and perform work in 
facilities suitable for molecular testing. 

To minimize contamination risk, follow good molecular biology practices, including physical separation 
of pre-amplification and post-amplification areas, use of aerosol-resistant pipette tips, and routine 
decontamination of work surfaces and equipment. Dispose of waste according to institutional 
procedures and local regulations. 

Chemical hazards associated with extraction reagents are specific to the extraction method used; follow 
the extraction kit manufacturer’s IFU and Safety Data Sheets (SDS). 
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Appendix A: Materials Required but Not Included  

All Workflows 

The following materials are required for nucleic acid extraction (if performed by the user) and for real-
time PCR setup and run on a compatible instrument. 

 

Category Components, Materials, or Reagents 

Personal protective equipment  Appropriate PPE (e.g., gloves, lab coat, eye protection) per 
institutional requirements. 

Liquid handling  Calibrated pipettes capable of dispensing 1 µL to 1000 µL 

 Aerosol-resistant (filter) pipette tips 

Consumables  RNase-free microcentrifuge tubes (for sample extraction and/or 
aliquoting) 

 Real-time PCR instrument consumables appropriate to the 
platform (e.g., plates or tubes/strips, optical seals/caps) 

Mixing and centrifugation  Vortex 

 Plate spinner / plate centrifuge (for brief spin-down of PCR 
plates, if using plate format) 

 Benchtop microcentrifuge (for brief spin-down of tubes/strips, as 
applicable) 

Temperature control and storage  Cold block or ice 

 Refrigerator, 2 °C to 8 °C (for short-term storage, as applicable) 

 Laboratory freezer, −15 °C to −25 °C (for kit storage) 
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Appendix B: Real-time PCR Instrument Setup and Analysis 

 ABI / Thermo Fisher: ABI 7500 / 7500 Fast *, QuantStudio 5 *, QuantStudio 6 Flex/Pro †, 

QuantStudio 7 Flex/Pro *, QuantStudio 12K Flex †, and ViiA 7. † 

 Qiagen: Rotor-Gene Q5/6 Plex * 

 Bio Molecular Systems: Mic * 

 Roche: LightCycler 96 *, LightCycler 480 II † 

 Bio-Rad: CFX96 † 

* Validated instruments. Refer to PANDAA Lassa Virus Compatibility with Major Real-Time PCR Instruments (page 20). 

† Compatible real-time PCR instruments that have not been validated with PANDAA Lassa Virus by Aldatu Biosciences. 

 

 ❚❛❜ 
CAUTION 

Ensure that your real-time PCR instrument has been installed, calibrated, and 
maintained according to the manufacturer’s instructions and recommendations. 

 

Use the real-time PCR run template provided by Aldatu Biosciences, available at www.aldatu.bio/qpcr-
templates. If your real-time PCR instrument is not listed then contact Technical Support 
(support@aldatubio.com) about your real-time PCR instrument requirements and configuration, and to 
obtain a run template file with the correct cycling conditions.  

Instrument Instructions 

Instrument Page 

ABI / Thermo Fisher Page 26 

CFX96 (Bio-Rad) Page 27 

LightCycler 96 and LightCycler 480 II (Roche) Page 29 

Mic (Bio Molecular Systems) Page 31 

Rotor-Gene Q (Qiagen) Page 33 
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ABI / Thermo Fisher 

Instruments: ABI 7500 / 7500 Fast, QuantStudio 5, QuantStudio 6 Flex/Pro, QuantStudio 7 Flex/Pro, 

QuantStudio 12K Flex, and ViiA 7. Templates (file extension .edt) provided by Aldatu Biosciences can 
be downloaded from www.aldatu.bio/qpcr-templates. 

Target Name Channel Reporter Quencher 

PANDAA Lassa Virus (LASV) Blue FAM NFQ-MGB 

Internal Control (IC) Red Cy5 NFQ-MGB 

Sample Adequacy Control (SAC) Yellow TAMRA NFQ-MGB 

ABI / Thermo Fisher Data Analysis 

Template files provided by Aldatu Biosciences are programmed with the analysis settings below.  

Target Name Threshold Baseline 

PANDAA Lassa Virus (LASV) 0.5 Auto 

Internal Control (IC) 0.05 Auto 

Sample Adequacy Control (SAC) 0.05 Auto 

1. Adjust threshold (LASV): Adjust the threshold for the LASV target so that the mean Ct of the 
Positive Control (PC) replicates is ~20 cycles (target range: 19 – 21 cycles). 

2. Analyze: Ensure that data are reanalyzed after any threshold adjustments.  

3. Save: Ensure that the analyzed .eds file is saved. 

4. Analysis: Proceed to data analysis with the PANDAA VHF Interpretation Software (page 14) using 

either the .eds run file or an exported Excel file. 

Using the .eds File Using the Exported Excel File 

Import the analyzed .eds file directly into the 
PANDAA VHF Interpretation Software. 

Export settings: From the Export menu, ensure 
that, at a minimum, the following content is selected 
for export. 

 Results 

 Amplification Data 

 Multicomponent Data 

Export: From the Export menu, choose *.xls or *.xlsx 
as the File Type and then export all data to one file. 
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CFX96 (Bio-Rad) 

Two separate template files are required for the CFX96, and can be downloaded from 

www.aldatu.bio/qpcr-templates: 

1. Protocol file: PANDAA Lassa Virus - Cycling Conditions - CFX96.prcl 

2. Plate file: PANDAA Lassa Virus - Plate Template - CFX96.pltd 

Using the .prcl Protocol File and .pltd Plate File 

1. Import protocol file: After starting a new user-defined run, import the .prcl template cycling 
conditions using Select Existing under the Protocol tab. 

2. Import plate file: Under the Plate tab, import the .pltd plate template containing the assay targets 
using Select Existing. 

Target Name Channel Fluorophore 

PANDAA Lassa Virus (LASV) 1 FAM 

Internal Control (IC) 4 Cy5 

Sample Adequacy Control (SAC) 2 Cal Orange 560 

CFX96 Data Analysis 

1. Show amplification cycles: After the run is completed, select the Step Number dropdown in the 
Data Analysis window and select 8 to show the data collected during the amplification cycles. 

2. Adjust settings: Under the Settings menu ensure that the following settings are selected: 

a. Cq Determination Mode ► Single Threshold 

b. Baseline Setting ► Baseline Subtracted Curve Fit 

c. Analysis Mode ► Target 

3. Adjust threshold (LASV): Adjust the threshold for the LASV target so that the mean Ct of the 
Positive Control (PC) replicates is ~20 cycles (target range: 19 – 21 cycles). 

4. Fluorescence cutoff: Under the End Point tab, edit the following settings for the LASV target: 

a. End Cycles to Average: 5 

b. Percent of Range: 5.0 

c. Record any wells that are not called (+) Positive by endpoint RFU. 
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5. Analyze and save: Ensure that data are reanalyzed after any adjustments and save the .pcrd file. 

6. Analysis: Proceed to data analysis with the PANDAA VHF Interpretation Software (page 14) using 
either the .pcrd run file or an exported Excel file. 

Using the .pcrd File Using the Exported Excel File 

Import the analyzed .pcrd file directly into the 
PANDAA VHF Interpretation Software. 

Export settings: From the Export menu, select 
Custom Export. 

 Choose Excel 2007 (*.xlsx) as the Export 
Format 

 Select all options for Sample Description and 
Quantification. Ensure that End RFU is 
selected as an export column. 
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LightCycler 96 and LightCycler 480 II (Roche) 

Instruments: A template file for the LightCycler 96 or LightCycler 480 II can be downloaded from 

www.aldatu.bio/qpcr-templates.  

Detection format: Hydrolysis probes. 

Target Name Channel Dye 

PANDAA Lassa Virus (LASV) 1 FAM 

Internal Control (IC) 4 Cy5 

Sample Adequacy Control (SAC) 2 Yellow555 

LightCycler 96 Data Analysis 

It is not possible to save analysis settings in the .lc96 template file provided by Aldatu Biosciences.  

1. Adjust threshold (LASV): Adjust the threshold for the LASV target so that the mean Ct of the 

Positive Control (PC) replicates is ~20 cycles (target range: 19 – 21 cycles). 

2. Adjust thresholds (IC and SAC): Place the IC and SAC thresholds in the exponential (log-linear) 

region above baseline and below plateau; apply the same setting to all samples and controls. 

3. Save: Ensure that the analyzed .lc96 run file is saved. 

4. Analysis: Proceed to data analysis with the PANDAA VHF Interpretation Software (page 14) using 

either the .lc96 run file or an exported text file. 

Using the .lc96 File Using the Exported Excel File 

Import the analyzed .lc96 file directly into the 
PANDAA VHF Interpretation Software. 

Ensure that the endpoint fluorescence (EPF) column 
is visible in the Results Table before exporting. If the 
EPF column is hidden, right click on the Results 
Table column headings ► Column Selector ► EPF 

Export: Right click on the Results Table ► Export to 
File ► Save as file type Text files (*.txt). 
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LightCycler 480 II Data Analysis 

Color compensation (multiplex): Apply an appropriate Color Compensation (CC) setting/object for 

multicolor assays before analysis. 

LightCycler 480 software reports the crossing point as Cp, which is treated as equivalent to Ct for 
reporting. To obtain Ct-equivalent values using a threshold-based method, use Absolute Quantification  
– Fit Points (threshold line method). 

1. Select analysis method: In the analysis modules, select Absolute Quantification ► Fit Points. (Fit 
Points uses a threshold line approach.)  

a. Select Analysis ► Abs Quant/2nd Derivative Max 

b. Under Method, select Fit Points (threshold line method) 

2. Adjust threshold (LASV): Adjust the threshold for the LASV target so that the mean Cp (Ct-
equivalent) of the Positive Control (PC) replicates is ~20 cycles (target range: 19 – 21 cycles).  

3. Save: Ensure that the analyzed .ixo run file is saved (.ixo is a supported export format on LC480). 

4. Analysis: Proceed to data analysis with the PANDAA VHF Interpretation Software (page 14) using 
either the .ixo run file or an exported text file. 

Using the .ixo File Using the Exported Excel File 

Import the analyzed .ixo file directly into the PANDAA 
VHF Interpretation Software. 

Export: Ensure that the endpoint fluorescence (EPF) 
column is visible in the Results Table. 

Right click on the Results Table ►Export to File ► 
Save as file type Text files (*.txt). 
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Mic (Bio Molecular Systems) 

The Mic Real-Time qPCR Cycler (Mic) from Bio Molecular Systems uses either an Assay definition file 

(file extension .micassay) containing cycling conditions, assay targets, and analysis settings, or a 
Template definition file (file extension .mictemplate), which additionally contains sample information. 
Templates provided by Aldatu Biosciences can be downloaded from www.aldatu.bio/qpcr-templates. 

1. Assay file: PANDAA Lassa Virus.micassay 

2. Template file: PANDAA Lassa Virus.mictemplate 

Target Name Channel Reporter Dye 

PANDAA Lassa Virus (LASV) Green FAM 

Internal Control (IC) Red Cy5 

Sample Adequacy Control (SAC) Yellow NED 

Storing the Assay and Template Definition Files 

The .micassay and/or .mictemplate must be saved in the local user document folder on your PC e.g., 
C:\Users\username\Documents\Bio Molecular Systems\micPCR\Templates. This folder should have 
been automatically created when installing the micPCR software. If this folder is missing, contact Aldatu 
Technical Support (support@aldatubio.com). 

Using the .micassay Assay Definition File 

In the micPCR software select Run from the New menu. In the new run file, click on the + icon next to 

Assays on the left-hand bar. PANDAA Lassa Virus can be selected from My Assays. If it is not visible 
then select Browse. Locate and select the PANDAA Lassa Virus.micassay file, which will now be loaded 
into your new run. 

Using the .mictemplate Template Definition File 

The PANDAA Lassa Virus.mictemplate contains the same cycling conditions, assay targets, and 
analysis settings as the .micassay file. It is also pre-loaded with the Negative Control in sample position 
1 and the Positive Control in sample position 48.  

Select Run from Template from the New menu in the micPCR software. Choose PANDAA Lassa Virus 
and click OK. If PANDAA Lassa Virus is not visible in the list of templates, confirm that it has been stored 

in the correct folder on your computer. Alternatively, start a new run using the .micassay file. 
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Mic Data Analysis  

Template files provided by Aldatu Biosciences are programmed with the analysis settings below.  

Target Name Method Exclusion Cutoff Threshold 

PANDAA Lassa Virus (LASV) Dynamic Extensive 5% Auto 

Internal Control (IC) Dynamic None N/A Auto 

Sample Adequacy Control (SAC) Dynamic None N/A Auto 

1. Adjust threshold: Adjust the threshold for the LASV target so that the mean Ct of the Positive 
Control (PC) replicates is ~20 cycles (target range: 19 – 21 cycles). 

2. Save: Ensure that the analyzed .micrun file is saved. 

3. Analysis: Proceed to data analysis with the PANDAA VHF Interpretation Software (page 14) using 
either the .micrun run file or an exported Excel file. 

Using the .micrun File Using the Exported Excel File 

Import the analyzed .micrun file directly into the 
PANDAA VHF Interpretation Software. 

Export: From the Save As menu, select Excel 
Workbook and save the exported .xlsx file. 
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Rotor-Gene Q (Qiagen) 

The Rotor-Gene Q uses template files with the file extension .ret. Start a new run in the Rotor-Gene Q 
software by selecting New ► Open a template in another folder, and select the PANDAA Lassa Virus 
- RGQ Template.ret file. The template file provided by Aldatu Biosciences contains the assay cycling 
conditions, targets, and gain settings and can be downloaded from www.aldatu.bio/qpcr-templates. 

Target Name Channel Source Detector 

PANDAA Lassa Virus (LASV) Green 470nm 510nm 

Internal Control (IC) Red 625nm 660nm 

Sample Adequacy Control (SAC) Yellow 530nm 555nm 

Gain and Auto-Gain Settings 

Auto-gain optimization is performed before the 1st acquisition. The Rotor-Gene Q template provided by 

Aldatu Biosciences, PANDAA Lassa Virus - RGQ Template.ret, is pre-programmed with this setting. Do 
not perform gain optimization at 60 °C at the beginning of the run. 

Rotor-Gene Q Data Analysis 

It is not possible to save analysis settings in the .ret template file provided by Aldatu Biosciences.  

1. Set global analysis settings for all three assay targets: 

 Dynamic Tube should be selected. 

 Slope Correct should be selected for consistent results across all runs. 

2. Set normalization options (LASV): In the analysis window for the LASV target, Outlier Removal 
should be set at 5% for the PANDAA Lassa Virus (LASV) target. 

3. Adjust threshold (LASV): Adjust the threshold for the LASV target so that the mean Ct of the 
Positive Control (PC) replicates is ~18 cycles (target range: 17 – 19 cycles).3 

4. Adjust thresholds (IC and SAC): Place the IC and SAC thresholds in the exponential (log-linear) 
region above baseline and below plateau; apply the same setting to all samples and controls. 

 

3  The threshold requirements for the Rotor-Gene Q differ to other instruments due to platform-specific differences in 
fluorescence reporting. Achieving accurate exponential-phase threshold placement requires positioning the threshold such 
that the mean Ct of the Positive Control replicates is ~18 cycles (target range: 17–19). At higher threshold settings, low-
copy reactions near the limit of detection may fail to cross the threshold, producing false negative results. 
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5. Save: Ensure that the analyzed .rex file is saved. 

6. Analysis: Proceed to data analysis with the PANDAA VHF Interpretation Software (page 14) using 
either the .rex run file or an exported Excel file. 

Using the .rex File Using the Exported Excel File 

Import the analyzed .rex file directly into the 
PANDAA VHF Interpretation Software. 

Export: Select File ►Save As ► Excel Analysis 
Sheet and save the .csv file. 
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Customer and Technical Support 

Email: support@aldatubio.com 

Address: Aldatu Biosciences  
313 Pleasant Street 
Watertown, MA 02472 
USA 

 

Disclaimers 

This kit is for Research Use Only and is not intended for use in diagnostic procedures. 

Aldatu Biosciences will not be liable for any direct, indirect, consequential or incidental damage related 

to or arising from the use, the results of use of this product or document. This User Guide Document is 
provided “as is” and is subject to being changed, without notice, in future editions. Aldatu Biosciences 
does not guarantee in any way that you will obtain satisfactory results from using this product as 
described herein. The only warranty provided is limited product warranty, that is, if this product does 
not meet the standard performance for control samples, the product will be replaced at no charge. 

 

Trademarks 

PANDAA® is a registered trademark of Aldatu Biosciences, Inc. PANDAA LASV, PANDAA Lassa Virus, 
and the Aldatu Biosciences logo are trademarks of Aldatu Biosciences, Inc. FAM® and ROX® are 
trademarks of Life Technologies Corporation. ABI Prism® (Applied Biosystems); CFX96® (Bio-Rad); 

Cy® (GE Healthcare); LightCycler® (Roche); Rotor- Gene®. All other trademarks that appear in this 
document are the property of their respective owners. 

 

Patents 

The PANDAA technology is covered by US Patent No. 10,100,349 and European Patent Application 
No. 3052656 owned by the President and Fellows of Harvard College and exclusively licensed to Aldatu 
Biosciences, Inc. 

 

 

Copyright 

© 2026 Aldatu Biosciences, Inc. 
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Explanation of Symbols 

 
For Research Use Only 

 
Catalog number 

 
Batch number 

 

Storage temperature range 

 
Use-by date 

 

Contents sufficient for n reactions 

 

Consult Instructions for Use 

 
Contents of the PANDAA® Lassa Virus kit 

 

Manufacturer 
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